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CONFIDENTIALITY 
 
HIPAA regulations mandate that all client information be treated confidentially. 

 
Access to CCBH is based on your position and your job classification. You will have the 
access you need to complete your job duties.  This can include access to clients in your 
Unit/SubUnit or may include full client look up.  Remember – with more access comes 
greater responsibility regarding confidentiality! 

 
You are not to share passwords with other staff.  The Summary of Policy you signed 
before receiving your access to CCBH included your agreement to this directive.  You 
are still responsible if someone with whom you have shared your password violates 
confidentiality! 

 
The MIS unit investigates any suspicions regarding sharing of passwords.  
Consequences are up to, and may include termination. 
 
Do not open any active client charts unless instructed to do so, or if it is required to 
complete your job duties.  “Surfing” clients is a blatant breach of confidentiality. 
 
Remember you are personally and legally responsible for maintaining confidentiality.  
Take it seriously. 
 
Do not leave your computer unlocked with client data on the screen for others to access 
or view while you are away from your desk. Lock your CCBH session before leaving 
your computer. 
 
When printing, make sure you are printing to a confidential printer, and pick up your 
paperwork quickly.  Leaving printed Protected Health Information (PHI) out is also a 
confidentiality violation. 
 

Play it safe – keep in mind how you would want your own PHI handled! 
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CLONED DOCUMENTATION 
 
 

From the Compliance Bulletin # 30, October 17, 2011 
 
  
 “When documentation is worded exactly like or similar to previous entries, the 
documentation is referred to as cloned documentation.  
 
“Whether the cloned documentation is handwritten, the result of pre-printed template, or 
use of Electronic Health Records, cloning of documentation will be considered 
misrepresentation of the medical necessity requirement for coverage of services. 
Identification of this type of documentation will lead to denial of services for lack of 
medical necessity and recoupment of all overpayments made.  
 
“It would not be expected that every patient had the same exact problem, symptoms, 
and required the exact same treatment. Cloned documentation does not meet medical 
necessity requirements for coverage of services rendered due to the lack of specific, 
individual information for each unique patient.  
 
“Documentation exactly the same from patient to patient is considered cloned and often 
occurs when services have a specific set of limited or select criteria. Cloned 
documentation lacks the patient specific information necessary to support services 
rendered to each individual patient.”  
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CLINICAL STANDARD FOR ASSESSMENTS IN CCBH  
 

The electronic health record (EHR) is a valuable resource for maintaining a centralized 
single medical record for all client clinical information.  During the course of treatment, a 
client may accumulate multiple Behavioral Health Assessments (BHAs), Psychiatric 
Assessments, and/or Discharge Summaries.  The system was designed to prepopulate 
or “pull-forward” information from certain fields in these assessment types from the most 
recent version into a newly opened version. This represents both an opportunity and a 
challenge.   
 
Given that a client can have multiple historical assessments, it is helpful if the most 
current clinical information that prepopulates can be readily available for review when 
opening a new BHA, Psychiatric Assessment and/or Discharge Summary.  Practically 
speaking, however, all information that prepopulates should not be summarily retained 
as portions of the assessments have become excessively long and have begun to lack 
clinical precision in describing the client’s current needs.  Since all historical information 
that has been final approved in these assessment types in CCBH exists for review at 
any time (for those who have access to the client’s EHR), it is not necessary to retain all 
information that prepopulates in every section of an Assessment.   
In 2011, the Clinical Standards Committee created standards addressing information 
that prepopulates into CCBH Assessments. In an effort to maintain the best clinical 
practice, these clinical standards have been revised by Quality Management to provide 
further direction on addressing information which prepopulates when adding new 
assessments in CCBH.  
 
When a Client is New to Your Program 

When adding a new assessment (BHA or Psychiatric Assessment) for a client 
that is new to your program and information has prepopulated from historical 
assessments, it is your responsibility to review each section in detail with the 
client for continued clinical relevance/accuracy.  It is not required to keep all 
historical information in a section.  Rather it is your responsibility to add, update, 
edit, correct, and/or retain appropriate clinical information that, in your 
professional opinion, is deemed relevant to the client’s current 
presentation/needs. You may delete information that has pre-populated for the 
purpose of greater accuracy in documentation of client’s current level of 
functioning and need.  (Please note, this information will always exist in the final 
approved version of the Assessments previously conducted and documented in 
CCBH).  

Standards for Specific Fields in the BHA and/or Psychiatric Assessment 
A. Presenting Problem:  Information that pre-populates the Presenting Problem 

section should be reviewed and summarized, as appropriate, as your first 
entry in the Past Psychiatric History section. Once summarized, the 
Presenting Problem information that has prepopulated should be deleted so 
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that the Presenting Problem information documented by you is specific to why 
the client is seeking services from your program at the time of the 
assessment.  

B. Clinical Formulation:  The Clinical Formulation section should be reviewed 
and summarized with information added to the Past Psychiatric History 
section, as needed.  Then any prepopulated information in this section should 
be deleted so that the documentation in that section can refer specifically to 
your program, documenting clearly your assessment of medical necessity and 
the client’s need for services at your program. 
 

C. The following additional fields have been identified as areas in which historical 
information should be evaluated for inclusion, revision or deletion (when it 
makes clinical sense to do so):  

a. Past Psychiatric History 
b. Family History 
c. Educational/Employment History 
d. Cultural Information 
e. Social History 
f. History of Violence 
g. Trauma questions 
h. Substance Use Information 
i. Military History 

Documentation Standards to Indicate Information in a Section of the BHA/Psychiatric 
Assessment is Being Retained or Edited 
 
When adding to a text field, start your documentation at the beginning of the text 
window. Label the field with the unit/subunit number of your program to indicate which 
program is providing information. Additionally, add the date of your documentation.  If 
the information that prepopulated is still current and well documented, and you are 
accepting the information without changes, type the heading “REVIEWED WITH NO 
CHANGES” at the top of the previous text.  If you want to add to or edit the existing 
information, type the heading “REVIEWED WITH EDITS” on top of the previous text and 
then proceed with adding your new information. Please note: your signature on an 
assessment for a client that is new to your program indicates that you have reviewed all 
information, made the appropriate clinical revisions, additions and/or deletions, and are 
in agreement with the assessment.  

 
When Adding Information to an Assessment for a Current Client: 

 
Assessments are meant to be “living documents” in that new information may be 
added over the course of services as new information or clinical formulations 
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become available.  If you have conducted the most recent assessment and are 
familiar with the client, it is not necessary to review each section in the entire 
Assessment. Rather, you may update just the sections for which you have 
knowledge of new information.  Follow the documentation standards for 
labeling/dating the field you are changing as described in the paragraph above. 
 

Concurrent Programs 
There are times when a client is open to two programs at the same time.  In this 
instance, it may be appropriate to leave relevant information from the other program in 
the Clinical Formulation section.  If a provider decides to do this (and their BHA is 
completed subsequent to the other program) their portion of the Clinical Formulation 
should be documented at the top of the text box and begun by listing their unit/subunit.  
To delineate the concurrent program’s Clinical Formulation information, their section 
should end with the following statement:  “Information below is retained as the client is 
concurrently receiving services from another program.”  
Similarly, when adding information for a current client who is being seen in another 
program concurrently, a program may wish to retain information throughout the BHA 
without making changes to it.  When this is the case, the program should delineate the 
other program’s information by documenting “Concurrent program information reviewed 
with no edits.” 
 
Procedure: Documentation in Discharge Summaries 

Documentation in Discharge Summaries should always be specific to your 
program and the services your program provided to the client.  It is not necessary 
to retain any information in the narrative text fields of the Discharge Summary 
that have prepopulated.  Delete information that has prepopulated and write only 
information specific to your program in each narrative section.   
 
 

For questions about these documentation standards or the procedures outlined 
above, please email the QI Unit at QIMatters.hhsa@sdcounty.ca.gov 

 
 
 
 
 
 
 
 
 
 

mailto:QIMatters.hhsa@sdcounty.ca.gov
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DIAGNOSIS PRACTICE GUIDELINES 
FOR THE ELECTRONIC HEALTH RECORD (EHR) 

 
PURPOSE:  
As part of the Cerner Community Behavioral Health CCBH electronic health record, 
each client has a single diagnostic profile that is utilized across the System of Care 
(SOC). With the implementation of ICD-10, the diagnostic profile contains relevant 
clinical information recorded in a non-axial format. This practice guideline establishes 
procedures for using the diagnostic profile in the EHR.  
 
PRACTICE GUIDELINES: 
Each program is responsible for ensuring that the client they are treating has the correct 
diagnosis included in the client's diagnostic profile (Diagnosis Form). All programs shall 
verify that the active diagnoses are in the EHR as per the following guidelines. 
 
When multiple outpatient programs are concurrently serving a client, they shall 
coordinate care around diagnoses. A Single Accountable Individual (SAI) is 
automatically assigned for each client in CCBH based on the priority level of the 
program. The SAI shall communicate with concurrent providers, and will facilitate 
updating the EHR.   
 
I. EXTERNAL PROVIDER: 

An External Provider is a licensed health care provider who has completed an 
assessment of the client within the past 12-months and who is outside the mental 
health Organizational Provider Network. Examples include a Fee-For-Service (FFS) 
providers or a provider outside of San Diego County. 

 
A. When it is not within a clinician's, or programs' scope of practice to enter a 

diagnosis, the clinician may use a diagnosis from an "External Provider". The 
begin date of a diagnosis from an external provider shall be the date of the 
assessment or referral. A diagnosis from an External Provider is only used when 
there is no other active diagnosis form in the client's EHR.  
 

B. The clinician shall complete the "External Provider" fields. The clinician shall 
enter the diagnostic information provided by the External Provider, the General 
Medical Conditions Summary Code, the diagnoses listed in order of priority, and 
the Trauma question.  
 

C. When the Administrative Services Organization (ASO) authorizes services for a 
FFS provider and there is no active Diagnosis Form in the client's EHR, the ASO 
shall complete the External Provider fields. ICD-10 Other specified, Unspecified 
codes or Z03.89 code may be used until a specific diagnosis is received from the 
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FFS provider. The ASO shall also complete the General Medical Condition 
Summary, and answer the Trauma Question. 
 

II. ENTERING THE DIAGNOSIS: 
When it is within their scope of practice, the clinician shall complete the Diagnosis Form. 
When it is not within a clinician's scope of practice to diagnose, a diagnosis may be 
used from an "External Provider". 
 

A. When an existing Diagnosis Form does not include the diagnoses for which a 
client is being treated at the program, that program shall add each diagnosis to 
the EHR with the date that the diagnosis was made. 
 

B. When there is no existing Diagnosis Form, the Diagnosis Form must be 
completed with a mental health diagnosis that has a begin date on or before the 
first date of service.  
 

C. There must be a SMHS reimbursable ICD-10 diagnosis listed as Priority 1 in 
order to claim for services.  
 

D. Diagnoses may not be ended unless all programs concurrently serving the client 
agree. Multiple programs serving a client must coordinate with each other 
regarding diagnoses.  
 

E. If a suspected mental health disorder is not yet diagnosed ICD-10 Other 
specified, Unspecified disorder codes or Z03.89 code may be entered until a 
specific diagnosis is determined.  
 

F. On the Diagnosis Form, the diagnosing clinician shall assign a priority to each 
diagnosis. When a diagnosis is being added to an existing form, it will be given 
the next priority (based on Begin Date). A diagnosis with a higher priority number 
does not indicate that the diagnosis is more clinically relevant than one with a 
lower priority number. The client treatment is not affected by the priority number 
given to a diagnosis. Please note, a substance use diagnosis cannot be priority 
one.  

 
III. DIAGNOSIS BEGIN AND END DATES: 

  
A. Changing a Begin Date 

Staff may change the begin date of a diagnosis to an earlier date to cover 
services provided at the program. Never change a begin date to a later date. 

B. Ending a Diagnosis  
a. If the client has only one open assignment (only open to one program)  

Staff may end a diagnosis if the client is no longer being treated for that 
diagnosis. 
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The end date must be on or after the last date of service for that 
diagnosis. 
 

b. If the client has multiple open assignments (open to multiple programs) 
Staff may end a diagnosis if the client is no longer being treated for that 
diagnosis at the program and all programs concurrently serving the client 
have been contacted and all agree to end the diagnosis. The end date 
must be on or after the last date of service for that diagnosis. Please note: 
never delete a diagnosis, only end if appropriate. 

 
C. Managing Diagnoses 

It is important to note that processes differ when a client is receiving services 
from more than one provider and by level of care (emergency services vs. 
outpatient). Remember that the client's record is now a single record across all 
providers involved in the care of that individual.  
 

IV. PRIORITIES FOR DIAGNOSES: 
A SMHS reimbursable ICD-10 mental health diagnosis must be listed as Priority 
1. The priority number in CCBH does not impact client treatment but does apply 
to claiming functions. When a diagnosis is added to an existing form, it is 
automatically given the next available priority number unless staff designate 
otherwise. 
 

A. Outpatient Providers 
a. When the EHR does not list the client’s treatment diagnosis 
 The outpatient provider shall add the treatment diagnosis and make it priority 1. 
 
b. When the EHR does list the client’s treatment diagnosis  
If the treatment diagnosis is listed, no action is required. 
 

B. Emergency Psychiatric Unit (EPU) and Emergency Screening Unit (ESU) 
a. When the EHR does not include the client’s treatment diagnosis  
The EPU or ESU shall add the treatment diagnosis and make it Priority 1.  

i. When the client leaves the EPU or ESU, the program shall end date the 
diagnosis that was added for that client. This will automatically return the 
existing diagnoses to their original priority.  
 

b. When the EHR does list the client’s treatment diagnosis as Priority 1  
If the treatment diagnosis is listed as Priority 1, no action is required.  
 
c. When the EHR does not list the existing client’s treatment diagnosis as Priority 
1  
The EPU or ESU shall change the client’s treatment diagnosis to Priority 1.  

i. When the client leaves the EPU or ESU, no action is required.  
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V. DIAGNOSIS CLEANUP:  
Programs are responsible for ensuring accuracy of diagnoses. Programs may “clean 
up” diagnoses that are no longer active.  

 
A. If client is not concurrently open to other programs, it is recommended to end the 

diagnosis that is no longer the focus of treatment. DO NOT DELETE THE 
DIAGNOSIS; ONLY END THEM. Use the final date of services with your 
program as the end date.  

 
B. If the client is concurrently open to other programs, collaboration between 

programs must occur before ending any diagnosis. It is not acceptable to end 
any diagnosis without coordination of care if there is more than one program 
providing services at the same time.  

 
VI. SUSPENSE ITEMS A & B:  

A. An active diagnosis must be in place in order to claim for service. The date of 
diagnosis must cover all dates of service.  
 

B. The diagnosis listed as Priority 1 must be a SMHS reimbursable ICD-10 
diagnosis. A Priority 1 diagnosis may never be a neurocognitive or substance 
use diagnosis.  
 

C. If there is an existing diagnosis listed that is the focus of treatment for the 
program, no action is required. Do not modify the existing begin date.  
 

VII. GENERAL MEDICAL CONDITION:  
The "General Medical Condition Summary Code" (GMC) field is a required field on 
the Diagnosis form. The GMC field is part of the CSI data that is reported to the 
State of California. The GMC field shall reflect any general medical condition which 
is impacting the client's mental health. The clinician shall complete the GMC field 
with any medical condition as reported by the client or obtained from another 
source (other medical record or report) and identify in the diagnosis “Comments” 
box the source of the medical condition. 
 
If the client's general medical condition is not listed in the GMC table, then "Other" 
shall be selected and the general medical condition shall be recorded in the 
diagnosis "Comments" box. 
 
NOTE: When a physical health diagnosis is given, it must also match the GMC. 
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CCBH SOFTWARE BASICS 
 
o CCBH IS ACCESSED THROUGH CITRIX (Cerner):   

Go to https://cosdca.cernerworks.com  
(Save this to your favorites or create a shortcut for your desktop) 

 

o “TAB TO TRAVEL”:  Get in the habit of using your “Tab” key.  Using the “Tab” 
assures that you are directed to all required fields and that the information you 
input is actually captured by the system. 

 
o RIGHT CLICK: When there is no obvious way to add information into a field, right 

click in the space to view your options. 
 

o FILTERS/RADIO BUTTONS: Check these first and make sure they are on “all” 
when searching the database. 

 

o MAGNIFYING GLASS/ELLIPSES “BUTTONS”: When you see these at the end 
of a field, it means there is a “Search Screen” that you can pull up to find 
information for that field. You do not have to use them, but they are there if you 
need them.  

 

o REQUIRED FIELDS are in red or blue: They must be filled-in to save and final 
approve information. 

 

o OPTIONAL FIELDS are in white: Information may be added, but is not required 
to final approve the Assessment. Keep in mind – just because you have 
completed all the fields required to final approve the form, does not mean 
you have completed a thorough clinical assessment. Documentation 
standards have not changed. 

 

o CLOSED FIELDS are in gray: Nothing can be added in these fields. 
 

o CASE SENSITIVE:   
 

o Passwords – if you receive an error message for “Invalid Password”, check to 
make sure you are using the appropriate upper and lower case letters when 
typing.  After a third attempt with an invalid password, the system will lock 
your session and will require contacting the Optum Support Desk                 
(1-800-834-3792) to unlock it.   
 

o Table Searches – when searching within a table, be aware that descriptions 
or IDs are case sensitive.  If you do not use the correct upper or upper and 
lower case entry, the search will not take you to the desired table value. 
 

o MULTIPLE WAYS TO ACCESS INFORMATION: In CCBH, it is easy to access 
the same information in multiple ways. We have included screenshots and 
directions in this document to guide you through the system.  

 

https://cosdca.cernerworks.com/
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o LOCKING YOUR SESSION:  For security purposes, you must lock your session 
any time you step away from your computer.  This packet explains the various 
ways to lock your session. 
  

Note:  Locking your session is best used for short times away from your computer.  
CCBH will log you out after 60 minutes.  There is a chance of losing work that has not 
been final approved or saved if CCBH logs you off. 

 
o WHEN YOU GO BACK TO YOUR PROGRAM:  You are learning how to enter 

assessments in the “SDC Train CCBH” environment during this training, which 
is for practice purposes only.  It is important to enter all of your assessment 
information in the “SDC Live CCBH” environment when you return to your 
program.   

 
• For password resets/menu issues:  Call the Optum Support Desk. You may also 

call if you need your “SDC Live CCBH” environment password or menu set up. 
Their contact information is:  

 
Optum Support Desk 

1-800-834-3792 
Reminder: 
 
Menu access is set according to job title/functions. The menus you have at your 
program may look different than menus shown in the screen shots in this packet.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

14 
Phase II Assessments REV 08/2023 

Assessments 

CCBH SPEAK 
 

Assessment In CCBH, anything that is not a Client Plan or a Progress Note is 
considered an “Assessment.” So, in CCBH Speak, forms such as the 
Discharge Summary, Outcome Forms, and Demographic Form are 
considered “Assessments” as well as the actual clinical assessment 
forms. 

Assignment  Opening/Closing a client to a specific program (Unit/SubUnit/s) and to 
a specific server. 

Clinician’s 
Homepage 

A “page” that provides the Clinical servers at each open assignment to 
view client/s and client information for the identified caseload in one 
screen. This includes client look up, caseload listing, appointments, 
task/s to do, notifications, and other client information present in the 
EHR.    

Collateral 
Server 

Co-Staff providing a service (i.e. co-facilitator). Used when more than 
one staff is providing a service to the same client, on the same date 
and at the same time as server. 

Demographic  A client is entered into the EHR by the completion and final approval of 
the demographic form. A client may not be opened to 
assignment/program unless the demographic form is entered, 
completed, and final approved. 

Final Approve Locks the completed assessment. Prevents editing/deletion of 
assessments. 

SAI – Single 
Accountable 
Individual 

Primary server identified based on primary unit program set up. This 
staff will be listed as the primary contact for the client in the system of 
care for purposes of coordination of care. 

Scheduler A program within the EHR that allows for scheduling of client service 
events and ongoing appointment/s. This information will populate to 
the Clinician’s Homepage once entered into the EHR through the 
Scheduler menu. 

Service Code Procedure Code.  The code data entered into the EHR for the purpose 
of claiming a service activity. 

Server Staff providing a service activity. 

Unit The Physical Location of a program, or legal entity. 

Sub-Unit The specialized set of services offered within a Unit (i.e. population, 
funding sources, etc.). 
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PASSWORD CHANGES 
 

Citrix (Cerner) Password 
 
The first Citrix (Cerner) password you ever receive is considered a temporary password.  
For security reasons, you will be prompted to change your password on your first log in.  
To do so after the initial login, click “Change Password” when first logging in to Citrix 
(Cerner).   
 

 
 

 
 
 
 
Next, follow the prompts to change your 
password. 

 
 
 
 
 
 

 
 

CCBH Password 
 
You are prompted by the system to change your CCBH password every 90 days.  
However, if you feel that someone has learned your password, for security reasons you 
should change it immediately.  There are two ways to do this: 
 
External View 

From the External View, go to the “Access” tab and 
select the “Change Password” option.  Follow the 
prompts to change your password.   
 

 
 
 
 Clinician’s Homepage 
 
From the Clinician’s Homepage, go to the 
File Tab. Select the “Security” menu, and 
then select the “Change Password” 
option.  Follow the prompts to change 
your password.  
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LOCK CCBH SESSION 
For security reasons, the expectation is that you will lock your CCBH session any time 
you step away from your computer.  There are two ways to do this. 
 

Clinician’s Homepage 
 
From the Clinician’s Homepage, go to the “File Tab” and select the “Security” drop down 
menu, then select “Lock Session” button.  
  

   
 

External View 
 

From the External View, go to the “Access” tab and select the “Lock Session” option.   
 

 
 
 
 
You will be prompted to enter your password to unlock the session.   
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EXITING THE APPLICATION 
 

EXITING CCBH:  To make sure you do not accidentally create a “ghost session” 
and lock yourself out of accessing CCBH, you must exit in the following manner: 

Clinician’s Homepage 
 
 
 

o Go to the “File Tab” menu in the top left-hand corner of your screen. 
o Select the “Exit Application” option. 

 

 
 

External View 
 

o Go to the “File” menu in the top left-hand corner of your screen. 
o Select the “Exit” option. 
o Repeat this step for any open external view window. 

 

 
 

You risk being locked out of CCBH if you do not exit in the manner described 
above! 
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CLINICIAN’S HOMEPAGE PREFERENCES 
How to setup and save preferences 

 
Accessing Preferences: 

 

 
 

 

A- From the “File Tab”  
B- Select the “Preferences” icon 

 

This feature allows you to set the Assessments that you use most frequently as 
preferences for easy access. 
 

Preferences for New Assessments: 
 

o Select the plus sign next to “New Assessments.” 
o Click “Commonly Performed Assessments” 
o Click “Add” 
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1) Select the assessment(s) you commonly perform. To select multiple 
assessments, hold down the “control” key as you click with the mouse. 
2) Once you have selected your preferred assessments, click the “Select” button. 

 
 

You will see your selections.  
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Saving Preferences: 
 

 
 
 
You have 3 options:  
 
Save: 

• Click the “Save” icon. This will save settings only. 
 
Save and Close: 

• Click the “Save and Close” icon. This will save your selections and take you back 
to the Clinician’s Homepage. 

 
Close Panel: 

• WARNING: If you click the “Close Panel” icon without saving, all of your 
preferences will need to be reset. 

 
 

Note: These preferences will not transfer from your TRAIN account to LIVE. They 
must be setup in LIVE too. 
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CLINICIAN’S HOMEPAGE TERMINOLOGY 
Identifying Terms Used on the Clinician’s Homepage  

 
Clinician’s Homepage: 
The Clinician’s Homepage is a real-time tool that provides up-to-the-minute client status 
at a glance.  
 
File Tab: 
It can be used to exit the application, set preferences, access the external view, or see 
recently opened views. 
 

 
 
Tabs: 
The “Tabs” listed below are displayed at the top of the Clinician’s Homepage. 
 

• There are four tabs: “File”, “Home”, “Client”, and “View.” 
 

 

Note: The “Client” tab will only be available if a client has been selected.  
 
 
Buttons: 

 
• The “Buttons” are individual selections that can be clicked on to perform various 

            functions.  
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Ribbon: 
 

• The “Ribbon” is an object that is comprised of various buttons.  
 

 
 
Staff Panel: 
The Staff Panel automatically launches when the Clinician’s Homepage is opened.   
 

 
 
You will see your name as well as your job title listed. If you believe that the job title is 
incorrect, you must complete a new ARF form and submit it to the MH MIS Unit for 
correction. 
 
 
Caseload:  
 
 
 
The Staff Panel defaults to show your caseload.  
These are the clients who have been assigned 
to you.  You can always return to your caseload 
by selecting the Caseload pane at the bottom of 
the screen: 
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Identifying Client Type: 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

You can find the client designation under 
the “Type” heading on the “Caseload” 
pane of the staff panel.  There are three 
client types that may appear on your 
caseload: 

 
• SAI:  this signifies that you are the 

Single Accountable Individual for the 
client listed. 
 

• Caseload:  this indicates that, in 
addition to your program, the client is 
being seen at another program.  You 
are not the SAI for this client type – the 
other program staff would be the SAI. 

 
• Pre-Intake:  this indicates that the 

client is temporarily on your caseload 
as a pre-intake client. Pre-intake is 
intended for the purpose of allowing 
brief access by a clinician to the Client 
Chart for the process of screening 
before the client is assigned to a 
Unit/SubUnit. 
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Scheduled Services: 

 
 
Any clients displayed in this pane are scheduled for service events that calendar day. 
You can always return to this pane by selecting the Scheduled Services pane tab at the 
bottom of the window. 
 
Client Panel: 
 

• The “Client Panel” displays information about the client that you selected.  The 
“Client Panel” consists of “Client Panes”. You may access the information 
contained in those panes by clicking on each pane.   
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CLIENT SEARCH 
 
Searching for a Client Who Is In Your Caseload:  
 

• On the Clinician’s Homepage “Home” tab, under “Caseload”, double click on the 
name of the client.  

• This action opens up the “Client Panel” where you can find information about 
your client.  

 

 
 
Searching a Client Who Is Not In Your Caseload: 
 

o Select the “Client Search” button 
 

 
 

o The “Client Lookup” window will open 
 

 
There are several different ways to search for a client from this window: 
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o By “Sort Name”:  Enter the client’s sort name in the LAST NAME, FIRST NAME 
format, then select the “Search” button. (The “Sort Name” is the client’s name as 
formatted when first entered into the CCBH system):   
 

 
 

o If the Sort Name you’ve entered is in the system, it will be displayed in the “Client 
Search Results” area, as in this screen shot which exemplifies a search done for 
fictional client sort name, “PIE, APPLE”: 

 

 
 

o If the Sort Name you entered is not in the system, you will receive the following 
stop message: 
 

 
 

o This does not mean that the client is not in CCBH.  Rather, you may not have 
entered the sort name exactly as it was formatted when the client’s information 
was first entered into the CCBH system.  For this reason, you should search by 
other criteria such as: 
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Note: Before beginning another type of search, select the “Clear” button to 
reset the search criteria.   

 
o In client search, enter LAST NAME, FIRST NAME, date of birth (check spelling 

and in ALL CAPS).  
o If client is found with that name, double check SSN.  

o Search by SSN.  
o Search by Alias.  

o If match found, open the Demographic form on client and double check 
DOB, address, SSN.  

o Check 3rd Party information to see if client has the same Medi-Cal (BIC, 
CIN) number.  

o If it is unclear which is the first name or the last name, enter the other position of 
names in Alias – e.g., Bubble Gum entered into CCI as GUM, BUBBLE may be 
entered into Alias as BUBBLE, GUM.  

 

Note: When searching use all capital letters, these fields are case sensitive. 
 

 
o You can now search by one or more of the other criteria fields (Last, First, DOB, 

Alias Last, First, Sex, Case Number).  Select the “Search” button. 
 

 

 Note:  If you search by data that is common in the system (such as conducting 
a search only by a common first name) you will receive the following warning 
screen.  This allows you the option to either continue with or cancel the search.   
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Additional Client Search Feature 
 

o The “Thru” field, in conjunction with the “DOB” field allows you to search for 
clients within a particular date range.  For example, if the DOB is approximately 
3/10/1964 and you enter 3/08/1964 in the “DOB” field and 3/12/1964 in the “Thru” 
field, all clients in the system who have that dates of birth in that date range will 
be displayed in the “Client Search Results” window. 

Note: If the exact DOB is known ~ enter it in the ‘DOB’ and ‘Thru’ fields to find clients born only on that date. 

NOTES  
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RESTORE SYSTEM DEFAULTS 
 
If the layout becomes distorted, or the panes have disappeared, select “Restore Panel 
Layout” (under the Layout and Filters button on the Home tab). This will restore the 
layout to what it was when you first logged in. 
 
I mean 
 
Select “Restore Panel Filters” (under the Layout and Filters button on the Home tab) to 
bring all the Filters back to their default settings, if desired.  
 

 
 

NOTES  
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CLIENT FACE SHEET 
 
The Client Face Sheet will allow users to view any entered information from the client’s 
most recent final approved Safety Alert, Demographic Form, and Diagnosis Form. The 
Client Face Sheet displays the Primary Unit, SubUnit and SAI for the client. If the client 
information has not been entered on one of these forms, the corresponding information 
fields on the Face Sheet will be blank.   
 

• After accessing a client, the Client Face Sheet can be viewed by clicking the “Face 
Sheet” pane in the client panel. 

 

 
 

• The Client’s Face Sheet cannot be edited from this view. To print click on the drop 
down arrow  at the top right, and click “Print Face Sheet”. 
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FILTER SETTINGS 
 

Modifying filter settings to display historical assessments 
 

Each user may personalize the way filters display information in his or her Clinician’s 
Homepage. Any time you do not see the desired information, the first step is to check 
the filters to assure the correct parameters are selected for your search. 
 

1. On the “Client Panel”, click on the “Assessments” pane.  The “Assessments” 
pane will open an expanded window.  

2. Click the drop down arrow  on the “Assessments” bar that displays on the right.  
3. A new window will display.  Click on the check mark  or on the word “Filters”.   
4. The “Filters” window will display. There are three areas where you can make 

changes: Lookback Date: This date pre-populates back 48 months from the date 
you open the filter.  If a desired assessment is before the date listed, and is not 
displaying on the “Assessments” tab; you can adjust the date manually.  

5. From the drop down menu, you may choose A: “Include Final Approved and non-
Final Approved Assessments”, F: “Include Final Approved Assessments only” or 
N-“Include non-Final Approved Assessments only”.   

6. You may also place a checkmark by the “Include the latest Assessment of each 
type only” choice given.  
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Filters in Clinician’s Homepage: 
 

Note: Filters will vary based on which pane is selected on the client panel. 
 
Several panes located within the Client Panel contain “Filters”.  Below are some 
examples:  
 

Assignments Pane Filters:  updates the Assignments Pane to display Opened and 
Closed Assignments.  
 

 
 
Services Pane Filter(s):  updates the display of the Services Pane.  The date field 
filters for services on or after the date entered.  Check boxes further filter that data, for 
particular service types or services by specified staff, for example.  
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VIEWING CLIENT ASSIGNMENTS 
Clinician’s Homepage 

 
Client “Assignments” refer to where the client has received, or is currently receiving, 
services. In the “Clinician’s Homepage” you can view the Opening/Closing dates when a 
client was assigned to a specific program (Unit/SubUnit/s) and to a specific server. 
 
 

A. In the “Client Panel” click on the “Assignments” pane. 
B. It displays all the assignments attached to the client.  

 

 
 
 

NOTES  
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ADDING NEW ASSESSMENTS  
 

• Access the desired client. 
• A “Client” tab will open with additional buttons listed within the ribbon. 
• The Client Panel will launch on the bottom portion of your screen. The name of 

the client will display in the client name box. 

Note: A client name must be displayed in the “Client Panel” to have the “Client” tab 
accessible. 
 

 
 
 
New Assessment Button: 
 

• The New Assessment button will be displayed in the “Client” tab ribbon. 
 

 
 

To see a complete list of assessments:  
 

• Click on the top portion of the “New Assessments” button.  
• The “New Assessment Lookup” window displays.  
 

 

Note: The new assessment button is segmented in two parts. The upper portion 
of the button is a list of all assessments available for entry. The lower portion 
consists of assessments that have been established as “New Assessments” in 
your “Preferences”.  
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Dating the Assessment: 
 

 
• Place the desired date in 

the date field.  
• Refer to the “GUIDELINES 

FOR DATES IN CCBH”. 
 

• Press the “Save” button. 
This will launch the 
assessment for data entry. 

 
 
 
 
 
 

 Note: Correct entry of the date is essential. Once the date is entered in the 
 above field, it cannot be altered.  

• Search for the desired 
assessment by using the scroll 
bar on the right side of the list. 

• Highlight the assessment you 
wish to launch. 

• Click “Select”. 
• The system will open the 

external view and the selected 
assessment to begin data entry. 

 

Note: Double clicking on the 
assessment will also launch the 
desired assessment. 
 
. 
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GUIDELINES FOR DATES IN CCBH 

 
Assessment Date: 
 
When adding an assessment, the system will require the entry of a date when opening 
the form for data entry. This is called the assessment date.   
 

 
 
 
 

 
The assessment date determines the date the assessment is sorted in the look up 
window. The assessment date must match the service date that is claimed in the 
system. Progress note documentation will need to support the service claimed. When 
an assessment service takes more than one session to complete, multiple service dates 
claimed must be indicated in each progress note for each service date. However, the 
assessment date entered in the MIS will remain the initial assessment service date.   
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Signature Date: 
 
Signature dates may be different than the assessment date, which is necessary at times 
(i.e. when a co-signature is necessary but the staff is out of the office). 
 

 
 

Note: Co-signatures must be completed within timelines. 
 
Final Approve Date: 
 
The final approval date may be different than the assessment date and/or signature 
dates. The final approval date is the date that the assessment is considered active and 
complete. This date will also drive the timelines for documentation reviews. 
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ENTERING A DIAGNOSIS 

 
1. To enter a diagnosis, locate the “Clinical Disorders/Conditions That May be A 

Focus of Clinical 
Attention” section on 
the form. 
 

2. Right click in the 
white space to see 
the option “Add New.” 
 

3. Click on “Add New.” 
 
 
 

 
 
 
 
 

• Enter the ICD-10 diagnosis code, if 
known. 

 
 
 
 
 
 

 
 
 
 
 

• If the ICD-10 diagnosis code is not 
known, click on the “Diagnosis” link 
and search for the diagnosis by 
entering a description.  
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• Fill in the fields you want to address, then click the “Search” button. 

 

 
 
 

• Your selection will appear in the 
“Diagnosis” field. Address the 
following the “Priority, Begin 
Date, and End Date” fields. 
When finished, click “Save and 
Close” button. 
 
Note: Refer to the Diagnosis 
Practice Guidelines section of 
this manual for important 
information regarding the 
“Priority, Begin Date, and End 
Date” fields.  
 

• The diagnosis entered will 
now appear in the “Clinical 
Disorders/Conditions That 
May be A Focus of Clinical 
Attention” section. 
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ELECTRONIC SIGNATURE GUIDELINES  
 

• Certain assessments in CCBH can be final approved by any clinical staff who 
have required system access, such as the Safety Alert or the Demographic 
Form. Anyone can complete the assessment and final approve as themselves, 
without a co-signature. 

 
• To final approve the Safety Alerts and Demographic Form 

 
1) Make sure all software required fields have been addressed.       

 
 

(a) To check, click the 
“Perform Validation 
Check” button at the 
top of the window. A 
screen will appear at 
the center of your screen with a list of fields to be 
addressed, if any. If all required fields have been 
addressed, you will not see a screen appear. When 
ready, proceed with the final approval step for the 
assessment. 

    
2) Click the 

“Final 
Approve” 
button 
located at 
the top of 
the window. 
 

 
3) Enter your CCBH 

password when 
prompted.  
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• Some assessments contain 

credential restricted signatures. 
For instance, there are three 
credential restricted signature 
lines located in the “Validations” 
pane of the Diagnosis Form, and 
two signature lines on the BHAs.  

 
• Your license type or credential will 

determine how you address each signature line. 
 
Staff Who Do Not Require a Co-Signature: 
 

1. Sequence 1 (Staff Requiring Co-Signature) - Left click and select “Delete.” 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

2. Sequence 2 (Staff Comp/Accept Assessment) – Left click and select 
“Electronically Sign.”  
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3. Enter your CCBH password when prompted.  
 

 
 
 

4. Sequence 3 (Staff Entering Information) – Left click and select “Delete.” 
 

 
 

NOTE: Sequence 3 is for administrative staff, entering on your behalf. Most assessments will 
have only Sequence 1 and Sequence 2. Follow the same procedure as mentioned above. 

 
5. Select “Final Approve,” located at the top of the window. 

 

 
 
Staff Who Require a Co-Signature: 
 

1. Sequence 1 (Staff Requiring Co-Signature) - Left click and select “Electronically 
Sign.”  
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2. Enter your CCBH password when prompted. 
 

 
3. Sequence 2 (Staff Comp/Accept Assessment) – Left click and select “Assign 

Signatory.” 
 
 
 
 
 
 
 
 
 
 
 

4. Find your supervisor by name or staff ID. Highlight their name and choose 
“Select” at the top. 
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5. Sequence 3 (Staff Entering Information) – Left click and select “Delete.” 
 

 
 

6. Click “Save and Close” located at the top of the window. After you click “Save 
and Close,” you return to the Clinician’s Homepage. The name of the client will 
display on the Notifications list on your Clinician’s Homepage and on the 
Homepage of the approved signer until the assessment is co-signed and final 
approved.    

 
 

 
 

Staff Who Final Approve (or Co-Sign) Assessments For Others: 
 

1. Find the client on your Notifications list on the Clinician’s Homepage. 
 

2. Access the assessment and review. The person for whom you are co-signing 
should have already completed Sequence 1 signature line and deleted Sequence 
3. 
 

3. Sequence 2 (Staff Comp/Accept Assessment) – Left click and select 
“Electronically Sign.”  
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4. Enter your CCBH password when prompted. 
 

 
 
 

5. Click “Final Approve” located at the top of the window. 
 

 
 

REMINDER: Co-signatures and final approval of assessments should be done as soon 
as possible. 
 
 
PLEASE REMEMBER: 

 Passwords may NEVER be shared as this constitutes a  
breach of security and HIPAA violation. 

 
 

NOTES  
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VIEWING ASSESSMENTS 
 

Saved forms:  
 

• Are “saved” but not final approved. 
• Can be edited or deleted by anyone who has access to that client’s forms. 
• Will hold up the work flow as they prevent adding another form in which any fields 

are shared.   
 

Lock it down by Final Approving to protect your work!! 
 
How to open a saved assessment: 
 

• Select a client and open the “Client Panel”. Next, click the “Assessments” pane.  
• A list of assessments will display. The assessment that is not final approved will 

not have a check under the Final Approved status (F/A). 
• Double click the assessment. The selected assessment will open for data entry 

and completion.   
 

 
 

VIEWING FINAL APPROVED ASSESSMENTS 
 

• Select a client and open the “Client Panel”.  
• Next, click the “Assessments” pane.  
• A list of assessments will display. The assessments that are final approved will 

have a check under the Final approved status (F/A). 
• Double click the assessment. The selected assessment will open for review. 
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PRINT TO SCREEN 

Note: Before printing a hard copy, always print to screen first to verify whether 
printing is truly necessary.  
 

• Click the “Print” button. 
 

 
 

• Click on the down arrow to the right of the “Printer” field, click “Print Preview”, 
and click the “Print” button. 

 

 
 

 
 
 
It will take a few moments to process the command. Wait 
until the following message disappears.  
 
 
 

 
A copy displays on the screen. Pay attention to the total number of pages before 
deciding to print a physical copy.  
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Icons  
 
You will find icons across the top of the print screen which will allow navigation through 
the copy.  
 

 
 

 Prints a physical copy. 
 

 Emails a copy. DO NOT use this feature, as it is a breach in confidentiality. 
 

 Displays the default size of the copy. 
 

 Shrinks the copy down to 25% of the default size. 
 

 Zooms in by 50% each time the icon is clicked.  
 

 Zooms out by 25% each time the icon is clicked. 
 

 Navigates directly to the first page. 
 

 Navigates back one page. 
 

 Navigates forward one page. 
 

 Navigates directly to the last page. 
 

 Displays keyboard commands for navigating through the copy. 
 

 Displays the details of the software product. 
 

• Closes out of "Print to Screen” and returns to the original view. 
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DISPLAY AUDIT EVENTS 
To see when an assessment was added, edited, final approved, viewed, or printed, 
utilize Display Audit Events. Display Audit Events will display who touched the 
assessment, when, and what action was completed.  

1. Right click on the assessment details you wish to view. Select “Display Audit 
Events.” 

 
 

2. Each column in the window that appears can be sorted by clicking on the column 
header. The window will display a line for each separate action a staff takes (add, 
edit, sign, final approve, display, and print).  

 
 

 
3. Select “Close Panel” to return to the 

Assessments Pane.  
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STAFF MAINTENANCE LOOKUP 
How to Lookup a Staff for Contact Information 

 
• From the CLINICIAN’S HOMEPAGE, click the File tab, click “Menu”, click 

“System Tools”, and click “Staff Maintenance”. 
 

 
 
 

• From the EXTERNAL VIEW, locate “Staff Maintenance” under “System Tools”. 
 

 
 
 
 
 “Staff Maintenance” Menu: 
 
When the “Staff Maintenance” Menu launches, your staff ID and name will be 
highlighted in blue as a default. Your current contact information on file will be listed in 
the “Main (1)” tab below. 
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To begin your search: 
 
• Press the “Find” button at the bottom of the window. 
• The “Search: Sort Name” box will launch. 

 
NOTE: You may search by “ID” or “Sort Name” by clicking under the desired column 
before pressing “Find”. A red dotted box will display under the field you  
are searching. 
 

 
 
 
 Search Window: 

 
 

• Type in the desired 
name of the staff you 
wish to find.  
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NOTE: The format must be last name, comma, then SPACE, and first name. For 
example, “CLINICAL, STAFF” would be the proper format. 
 

 
 

• The contact information of the staff for which you have entered will display under  
“Main”.  

 
• The “Internal Phone” number as well as the “Email Address” will be listed when it 

is available. 
 

NOTES 
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CLINICIAN’S HOMEPAGE NOTIFICATIONS PANE 
Managing Notifications and Timelines 

 
Notifications are intended to assist in managing tasks related to quality and coordination 
of care for each client. The primary server at each program continues to be responsible 
to manage and track all necessary actions required by the County system of care for 
each client.  
 
Due to a shared electronic health record for each client, a complete and up-to-date 
behavioral health assessment must be present in each client record. There will no 
longer be multiple assessments for each program. Timelines for due dates may be 
impacted when a client is open to more than one program at one time (due dates will be 
driven by the most recent final approved BHA). The primary server at each program is 
responsible to coordinate due dates and clinical information between programs when 
this does occur. 

 
There are two ways to see the details of a “Notification”: 
 

1st Way 
• To display the action required for the client, right click anywhere on the line where 

the client’s name displays. This will activate a drop down menu with several options. 
Select the “Notification Detail” option.  

 

 
 

 
• When the “Notification Detail” option is selected, the “Client Notifications” window 

activates, displaying what action is required for the client. Double click on the line to 
open. 
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2nd Way 
• In the staff panel on the notifications pane, either right click on the line and 

choose “Launch Notification” or double click anywhere on the line. 
 

 
 
 
Timelines to Keep in Mind: 

 
• A Behavioral Health Assessment (BHA) must be completed within sixty days 

after the opening of a client assignment. 
 
• A client’s annual review date is established by most recent final approved BHA 

(check the notification dates for details). 
 
• A Discharge Summary must be completed within 7 days after a client’s 

assignment to your program is closed. 
 
Example: 
 

 

Open Date BHA Completed BHA Update Due 

Program A    
Program B    
Program A    
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ENTERING A NEW PRE-EXISTING MEDICATION 
 

• View the medications listed in the “Medications” pane.  
 

 

• If the client reports taking a medication that is not listed, click the “New Pre-
existing Medication” button. 
 

 
 
 

• A new window launches. In the “Medication” field, type in the first few letters (at 
least three) of the medication, and click “Search”. 
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• Locate the 
appropriate 
medication 
from the list, 
and double 
click on it, or 
click once and 
choose 
“Select” at the 
top. 

 
 
 
 
 

• Once you’ve chosen the medication of your choice, a new window launches. The 
only other “software required” field is “Start Date”; however, clinically, if you have 
additional information, enter it into the “Sig Builder” and “Sig Information” fields. If 
prescribed by an external provider, select the name of the physician in the 
“Prescribing Physician” field. When finished, select “Save”. 

Note: If you do not have the exact start date, select the “Estimated Dates” box. 
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• Click the “Final Approve Changes” button. 

 
 
 

• The medication then displays in the “Medications” pane of the client panel. 
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EDITING A PRE-EXISTING MEDICATION 
 

Note: The “Edit” option will only show for Non-Final Approved Pre-Existing 
Medications. Otherwise, the menu will be greyed out. 

 
1. Select the appropriate client, and double click on the medication you wish to edit in the 

“Medications” pane. 
 

 
 

2. The client’s medications appear in a new window. Right click on the medication you wish 
to edit. A drop down menu appears. Select “Edit”. 
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3. The “Medication Details: Edit Prescription” window launches. Make the appropriate 
change in the “Sig Builder” portion of the window. In this example we will change the 
frequency from 3 times a day to 2 times a day. In the “Internal Notes” section, enter what 
change was made and when it was made. Then, select the “Save Medication”.  
 

 
 

4. Click the “Final Approve Changes” button. 
 
 

 
 
 

5. The edited prescription then displays in the “Medications” pane of the client panel. The 
change that was just made can now be observed in the “Sig” column. 
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DISCONTINUING A PRE-EXISTING MEDICATION 
 

Prescriptions are automatically discontinued in DHP if there is an end date in the Sig 
Builder and the end date has passed. However, there may be time when you want to 
discontinue a medication in the client’s record (for example, you find out that the pre-
existing medication that was prescribed by another Prescriber has been terminated, or 
you learn the client has stopped taking a medication).  Discontinuing a medication does 
NOT alert the pharmacy- you must contact the pharmacy directly to let them know. 
Unless you are a medical staff with access to Doctor’s Homepage you will only have 
access to discontinue pre-existing medications, not prescriptions. 
 

1. Select the appropriate client, and double click on the medication you wish to discontinue 
in the “Medications” pane. 
 

 
 

2. The “Medications List” for that client will launch. Right click on the medication you wish 
you discontinue. A drop down menu will launch. Click on “discontinue”. 
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3. The “Medication Details: Discontinue Prescription” window launches. The end date will 
default to the current date (but may be changed). Click “Save Medication”. 
 

 
 

4. You are returned to the “Medications Maintenance” window. A green check now appears 
in the “Discontinued” column for this medication. Click the “Final Approve Changes” 
button. 
 

 
 

5. The discontinued prescription then displays in the “Medications” pane of the client panel 
with a green check-mark in the “Discontinued” column. 
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VOIDING A PRE-EXISTING MEDICATION 
 

The use of “Void” is only completed on medications that have been Final Approved in 
error (such as accidently entering a medication for the wrong client).  Unless you are a 
medical staff with access to Doctor’s Homepage you will only have access to void pre-
existing medications, not prescriptions. 
 

1. Select the appropriate client, and double click on the medication you wish to void in the 
“Medications” pane. 
 

 
 

2. The “Medication List” for the client launches. Right click on the medication you wish to 
void and click, “Void”. 
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3. A new window launches which allows narrative text to be entered. Document the reason 

for voiding, and click “Save and Close”. 
 

 
 

4. The “Medication Maintenance” window is launched. Click the “Final Approve Changes” 
button. 
 

 
 

5. The voided prescription then displays in the “Medications” pane of the client panel with a 
check mark in the “Voided” column.  
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DELETING A PRE-EXISTING MEDICATION 
A medication can only be deleted BEFORE it has been final approved. You would do 
this, for example, if you are in the middle of a prescription and realize you’ve made an 
error. Unless you are a medical staff with access to Doctor’s Homepage you will only 
have access to delete pre-existing medications, not prescriptions. 
  

1. In the “Medication Maintenance” window, right click on the medication you wish to 
delete, and click “Delete.” 
 

 
 

2. The following message will appear. Click “Yes.” 
 

 
 

3. The medication is removed from the “Medication Maintenance” window. Click “Close 
Panel.” 
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PRINTING CLIENT MEDICATIONS 
A list of the client’s medications can be printed from the Medications Pane. 

1. With the Client panel open, select the “Medications” pane at the bottom of the screen. 
 

 
2. On the right top portion of the Client panel, select the down arrow. 

 

 
 

3. A drop down menu will launch. Select the “Print 
Medications” option. 

Note: This menu will also appear when right clicking in 
the white space within the client panel. 

 
 
 
 

4. Adjust the printing options to what is needed. Users can choose to print only a certain 
medication type, to include pre-approved or discontinued medications, and/or to include 

all medications or 
only current 
medications.  

 
5. When finished 

adjusting the filters, 
select “Print.” 
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SCHEDULER 
 
Scheduler is a comprehensive support system that helps clinicians to manage their 
clients’ treatment plans. With the Scheduling System, you have the flexibility to define 
schedules for clients and clinicians. You can view a schedule over one day, two days, a 
week, or a month.  
 
The portion contained in this packet is a limited version of how you can use Scheduler. 
Several Administrative staff have been trained in this part of the software in depth.   
 
There are multiple ways to access Scheduler in CCBH.  
 
From the External View: 
 

• Click on the “Scheduler” menu.  
• A drop down menu will display, select “Scheduler Maintenance- Multi Day”.  

 

 
 
From the Clinician’s Homepage 
 

• From the “File tab”, select “Menu”, then “Scheduler”, then “Scheduler 
Maintenance - Multi Day. 
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The Multi-Day screen will display.   
• “Entity Type” will default to Staff. 

 

 
 

 
To view a schedule 
 

1. Enter the CCBH ID number in the “Entity” field and press the tab key on the 
keyboard. NOTE: If you wish to view a schedule for a client instead of staff, 
change the “Entity Type” to “Client”, and enter a client case number in the “Entity” 
field  

2. Leave the “Location” field on “All” 
 

 
 

NOTES 
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To schedule a service event 
 

• Right click into the actual day the event is to take place (Ex: 10/9/14). 
• A floating menu appears. 
• From Floating menu: Select “New Individual Service (Version Q)”. 

 

 
 

A. The “Subject” can be manually 
entered, or it can be left blank. If it is 
left blank, it will default to the service 
code description after selecting the 
service code  

 
B. Enter the “Start Time”. The system will 

default to “am.”  Either enter military 
time, or the letter “p” for pm. For 
duration, enter as H:MM  (i.e. forty-five 
minutes is :45 and one hour and 
fifteen minutes is 1:15).The system 
will calculate the “End Time” 
automatically 
 

C. Select the client from the “Client Look 
Up” screen   

 
D. When the “Unit” is entered, the 

“Location” field automatically fills. 
Enter the Sub Unit 
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E. The “Staff” field defaults to the entity selected when you originally right clicked on 
the Multi Day View; however, the staff person can be changed  

 
 
 

• From the drop down 
menu, select the 
intended Service 
Code for the service 
event 

 
 
 
 

 
 
 
 
 

• Once a service code is selected, 
the service indicators auto fill  
 
 
 
 
 
 
 

 
 

 
• If the place of service is 

different than the default for 
“Prov. At”, enter the correct 
“Provided At” from the “Place 
of Service” look-up 
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• Enter an “Outside Facility” if “K”, “D”, or 
an “S” is selected as the place of 
service  

 
 
 
 
 
 
 

 
 
 
 
 
 

• The other indicators 
can be changed if 
desired. Click “Save” 

 
 

 
 
 

 
• Select “Save” and the service will now appear on your schedule. 
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SCHEDULER INSTRUCTIONS FOR CLINICIANS 

Multi-Day View 
The Multi-Day View allows the user to enter appointments on behalf of an individual 
staff and to view one staff person’s daily, weekly, monthly or multi-day schedule. Client 
services may also be entered and viewed in the Multi-Day View. 
 
To access, select Scheduler from menu, select Scheduler Maintenance-Multi-Day from 
the Scheduler menu drop down.   
The “Multi-Day View” screen will open.   

Entity Type 
Entity Type defaults to “Staff”. To change Entity Type, From the Entity Type drop down 
menu, select “Staff” or “Client” to view either staff or client’s schedule. The “Entity” field 
selection list is dependent on the selection in the Entity Type Field.  

Entity 
Select the magnifying glass to view lookup. Select the desired staff or client. If “Staff” 
was selected in the Entity Type field, the “Staff Lookup” screen will appear. If “Client” 
was selected in the Entity Type field, the “Client Lookup” screen will appear. The staff 
member’s schedule will display. Services can be added or edited, but my only be 
deleted by the Help Desk.    
 
The selected client’s services will be displayed and can be edited or canceled. Since 
staff schedules cannot be viewed from the “Client Screen”, do not add client 
appointments from this view. Adding client appointments from this view may result in 
double booking staff. Once the staff or client has been selected the event icons will 
activate.   

Locations 
Locations default to “All”.  A “Location Code” if entered will filter the selected staff 
person’s schedule for that site. In most cases, leaving it on “All” has the same result. 
When client is selected as the “Entity Type” and a specific client is selected as the 
“Entity”, leaving the “Location Code” set to “All” allows staff to view all of that specific 
client’s appointments that have been scheduled at any site.   
 
To return the default “All”, clear the location code in the field and tab out.   

Version Q 
Version Q is a screen used for scheduling with fewer fields to complete than the 
individual client service screen. Version Q does not allow for the scheduling of a 
collateral server or editing of a scheduled individual service event, or for comments to 
be added. However, once a service is scheduled with Version Q, it may be edited to 
include collateral server and comments by editing the Individual Service event.  
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Select “New Individual Service (Version Q)” in the drop down menu to schedule a client 
service event.      
 
Complete the “Subject” line. Enter a subject or a comment that may provide additional 
information (i.e. Translator needed for client). If no information is entered into the 
subject line, it will default to the service code description after selecting the service 
code.   
 
For a “Normal” appointment event enter the “Start Time” followed by an “A” (or “a”) for 
a.m. or “P” (or “p”) for p.m. and the duration of the event. (i.e.  If the length of the event 
is 1 hour and 45 minutes, enter 1:45 or military time). This will populate the “End Time”. 
 

Note: In Scheduler the period (.) is not recognized in all start /stop time fields.  
 
Select the client from the “Client Look Up” screen.   
 
Enter the “Unit” and the “Location” field will automatically fill. Enter the “SubUnit” 
(required although this appears optional).   
 
The “Staff” field defaults to the entity selected; however, the staff person can be 
changed.   
Select the intended Service Code for the scheduled event from the drop down menu. 
Once a service code is selected, the service code indicators will autofill. (Note: case 
management service codes do not autofill) If the “Prov. At” (Place of Service) is different 
than the default, enter the correct “Provided At” from the “Place of Service” look-up. 
Enter an “Outside Facility” if “K”, “D”, or an “S” is selected as a Place of Service. Other 
indicators can be changed. Select “Save”. 
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Client Categories Maintenance 
 
Entering Client Categories Maintenance: 
Once the program has confirmed that a client belongs in one of the client categories in 
CCBH, programs must make the appropriate designation. There is a brief glossary 
attached about each category. 
 
This is done through the “Client Categories Maintenance” screen. 
 
Once the client’s name has been selected from the CHP (and the Client Panel is 
open), follow these steps: 
 

1. From the Clinician’s Homepage (CHP), go to the File tab in the top left-hand 
corner. 

 
Select Menu  Client Data  Client Assignments  Client Categories 

Maintenance 
 

2. The “Client Categories Maintenance” window will launch, with the name of client 
you selected on your CHP pre-populated in the “Client” field. (If you did not 
select a client prior to this step, simply enter the client number in this field and 
select “Tab” to populate the client’s name).  
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3. Click in the “Category” column. This will activate the field for data entry. Use the 
magnifying glass icon at the end of that field to launch the “Client Categories 
Lookup” table. Select the appropriate option for your client. 

 

  
 

 

4. Your selection will now populate the “Client Categories Maintenance” window tab. 
Using your mouse, click in the “Effective Date” field to add the date it was 
determined the client was eligible.  

 
5. Once the date has been entered, click on the “Save” button. Then, select the “Exit” 

button at the bottom of the screen. 

 
6 .  When the program has confirmed that the client is no longer eligible, the program 

must return to the “Client Categories Maintenance” screen to enter an end date. It 
is the same steps as 1-2 & 4, except the program is entering information into the 
“End Date” instead of the “Start Date” column.  
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Once the end date is entered, click on the “Save” button. Then, select the “Exit” 
button at the bottom of the screen. 

 

 
 

Client Category Maintenance Glossary 
 

AB109 
A funding source for clients that are low risk offenders released from State custody to 
the County of San Diego for supervision and services. Alcohol, Drug & Mental Health 
services at various programs are provided to those that qualify for them. The goal is to 
provide supportive and rehabilitative services to these individuals to help them meet 
their needs and stay out of the justice system.  
 
“AB109 Funded” are those programs that have a contract with the County to provide 
services to this population, and the “AB109 Non-Funded” are programs that an AB109 
designated client may go to if the funded programs are full and impacted, but the 
program is not receiving contract funding for the services. The “Funded” programs are: 
CRF HEARTLAND CENTER, CRF MARIA SARDINAS WELLNESS & RECOVERY, 
EXODUS CENTRAL, and TELECARE PROPS. 
 
Assertive Community Treatment (ACT) 
ACT Services are provided in a multi-disciplinary team-based model of service that uses 
a comprehensive team approach and provides treatment 24 hours a day, 7 days a 
week, 365-days a year.  The services are targeted for homeless persons with a severe 
mental illness who may have a co-occurring disorder, are unconnected to outpatient 
services, may be referred by the justice system, have multiple major areas of 
impairment, have more than one long term care episode, and multiple ER and acute 
care hospitalizations and justice related episodes. 
  
The ACT program provides integrated mental health and medication services, 
rehabilitation and recovery services, intensive case management and have a staff-to-
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client ratio of approximately 1:10.  Clients are typically provided services in person at a 
minimum of four (4) times per week to meet with the client’s clinical needs and meet 
ACT fidelity rating.  Services may be provided on a much more frequent basis, 
depending on client need.  
 
ACT Strength-Based Case Management (SBCM) 
Strengths-Based Case Management services are delivered through BHS contracted 
service. Programs assist clients with severe mental illness who may have a co-occurring 
disorder to access needed mental health, medical, educational, social, prevocational, 
vocational, housing supports and rehabilitative or other community services.  The 
service activities may include, but are not limited to case management, care 
coordination, referral and linkage to needed services; monitoring services delivery to 
ensure beneficiary access to services and the services delivery system, monitoring of 
the client’s progress, and plan development 
 
AOT Court Ordered  
Assisted Outpatient Treatment, also known as Laura’s Law, is a process by which the 
court, after a thorough investigation, orders an individual into an appropriate level of 
treatment.  Individuals who are ordered into treatment are required to meet 9 criteria 
under Laura’s Law with the primary deciding clinical factor being client is “substantially 
deteriorating.”  As part of the petition process, the licensed mental health clinician must 
prove to the court via an AOT evaluation that this level of treatment is the least 
restrictive level of treatment and, if not ordered, may result in the decompensation of the 
individual.  The treatment offered in this category is the same level of treatment as an 
Assertive Community Treatment model.   
 
AOT Voluntary 
Similar to AOT Court Ordered, the individual is required to meet nine criteria under 
Laura’s law with the primary deciding clinical factor being client is “substantially 
deteriorating.”  In this category, however, the client has not been court ordered into 
treatment.  Though the client has met the definition for Laura’s Law and a licensed 
mental health clinician has conducted an AOT evaluation, the client has willingly agreed 
to participate in the AOT program and avoid the court process.  The treatment offered in 
this category is the same level of treatment, an Assertive Community Treatment model, 
offered to individuals in the AOT Court Ordered category. 
 
Augmented Services Programs (ASP)  
Strive to enhance and improve client functioning through augmentation of basic Board 
and Care (B & C) services to specific individuals living in specific B & C facilities with 
which the County has an ASP contract. Emphasis is on developing client strengths, 
symptom management, and client self-sufficiency. Priority for ASP services is given to 
those people in most need of additional services. Any BHS funded case management 
services program may refer to ASPs. 
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Emergency/Transitional Shelter Bed 
The goal of ETSB is to provide short term housing assistance to individuals connected 
to the respective clinic while stable income is sought. Emphasis is on securing stable 
income, symptom management, and client self-sufficiency. Priority for ETSB services is 
given to those people with a pending SSI claim. 
 
BHS Regional Clinics (North Central, East County, North Inland, and North Coastal) are 
the designated locations for referrals to the Emergency & Transitional Shelter Bed 
(ETSB), through the respective clinic Homeless Outreach Worker (HOW). 
  
Katie A.  
A shorthand way of referring to the settlement agreement for a class action lawsuit 
brought against the County of Los Angeles and the State of California. The result is that 
specific collaboration between County Behavioral Health Systems and Children’s 
Welfare Services is mandated so that certain children in both systems of care are 
guaranteed to receive intensive services to address their needs of safety, permanency 
and well-being. It is for Children’s programs only. In San Diego County, we refer to Katie 
A. as Pathways to Well-Being or the acronym PWB, so you may hear this language in 
your program. The class action lawsuit settlement defined members of the class and 
members of the subclass. These are legal terms that spell out what criteria need to be 
met in order to receive the specialty mental health services that the settlement defines. 

 
A clinician in your program will give you a form that says if the client meets criteria for 
Katie A Class or Subclass. This is the information you will put into Client Categories 
Maintenance. There have been several trainings on PWB, so if you are unfamiliar with 
this and the services provided (and you work in the Children’s System of Care) talk to 
your program manager for more specific information. 
 
Parolee 
On a regular basis, individuals are discharged on parole from California State penal 
institutions. In many instances, these persons are in need of mental health services. 
Parolees who fall under the Forensic Conditional Release Program (CONREP) will be 
provided services in accordance with the current contract between the California 
Department of Health Care Services and the County of San Diego. Parolees who are 
Medi-Cal beneficiaries and who meet specialty mental health medical necessity 
requirements, as specified in WIC 14184.402(A), 14059.5 and Section 1396D(5) of Title 
42 of the United States Code, will be provided appropriate Medi-Cal covered mental 
health services. Due to the passage of SB 389, MHSA funds may be used to provide 
services to persons who meet existing eligibility criteria for MHSA-funded programs and 
who are participating in a pre-sentencing or post-sentencing diversion program, to 
provide services to persons who are on parole, probation, PRCS, or mandatory 
supervision. 
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SUPPLEMENTAL REPORTS  
 
The reports listed below may be utilized for monitoring and maintenance of Assessments. Only 
designated staff in each program will have access to the reports that they are authorized to use. For 
additional assistance with approved template reports, please contact the Optum Support Desk at 1-800-
834-3792. 
 
ASSESSMENT REPORTS 
 

 
 
 
Assessments Final Approved by Primary Signer:  
Used to determine who has entered Assessments in to CCBH during a specified 
timeframe.  Can be used to determine who is actively entering in Assessments based 
on the timeframe entered and can indicate if a staff needs a re-training prior to 
registration for the Client Plan and Progress Notes training. 
 

1. Click on the “ATP” menu 
2. Click on “ATP Reports” submenu 
3. Select “Assessment and Treatment Plan Listing” 
4. Select “Load” and click on “Assessments Final Approved by Primary Server” and 

select “Load” again 
5. On “Selections1” enter in your Primary Unit 
6. On “Selections2” enter in the “Final Approved Dates” and “thru” (recommendation 

is to run for a two to four week duration) 
7. Select “Print” 
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Assessments Not Final Approved:  
Used to determine who has entered and not final approved Assessments in to CCBH 
during a specified timeframe.  Can be used to assure co-signatures are occurring within 
timelines, to determine if staff is completing assessments correctly, and determine if 
assessment/s are outstanding in the client chart. 
 

1. Click on the “ATP” menu 
2. Click on “ATP Reports” submenu 
3. Select “Assessment and Treatment Plan Listing” 
4. Select “Load” and click on “Assessments Not Final Approved” and select “Load” 

again 
5. On “Selections1” enter in your Primary Unit 
6. On “Selections2” enter in the “Final Approved Dates” and “thru” (recommendation 

is to run for a two to four week duration) 
7. Select “Print” 

 
NOTES  
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TRAINING TIP SHEET 
 

1.  WHEN YOU GO BACK TO YOUR PROGRAM:   
       You are learning how to enter assessments in the “SDC Train CCBH” 

environment during this training, which is for practice purposes only. It is 
important to enter all of your assessment information in the “SDC Live CCBH” 
environment when you return to your program.   

 
2. SUPPORT DESK – IMPORTANT!:   

      Please do not try to solve issues by “working around” the system. You are to 
enter data as required and you must call the Support Desk for any questions. 

 
         The Support Desk contact information is: 
 

Optum Support Desk Contact Information 
800-834-3792 

sdhelpdesk@optum.com 
 

3.  FOR ONLINE USER MANUALS AND FORMS: (including forms and form-fill versions of 
assessments for “emergency” situations) go to the Optum website below and follow 
these instructions:  

 

https://www.optumsandiego.com 
 

         Click "Register" to get an on-line form for your personal login. 
   Confirm your email address. 
         When you have access, click “Login”. 
         Login with your User Name and Password. 
         Go to "Secure Documents". 
     Select CCBH (formerly Anasazi) Secure Documents 
         Click "Forms" or "Manuals". 

 
4. TO REGISTER FOR ADDITIONAL TRAINING:  
 
 

www.regpack.com/reg/optum  
 

 

5. HIPAA REGULATIONS FOR TRAINING: There is actual client data (names, etc.) in the 
training environment. HIPAA regulations mandate this information be treated 
confidentially. 
 

6. NON-USE OF CCBH ACCOUNT: Inactive accounts pose a security risk by allowing an 
opportunity for unauthorized access. Therefore, in order to safeguard protected health 
information, inactive accounts will be closely monitored. Users who have not used CCBH 
in 90 days will have their account deactivated.  

 
 
 
 

https://www.optumsandiego.com/
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Support Desk Contact Information 
sdhelpdesk@optum.com 

1-800-834-3792 
Monday through Friday (E-mail) 

Hours Services 
6:00 am to 6:00 pm All services except password resets or any service involving PHI 

Monday through Friday (Telephone) 
Hours Services 

4:30 am to 6:00 am Resetting passwords (24 hour programs) and reporting system outages* 
6:00 am to 6:00 pm All services 
6:00 pm to 11:00 pm Resetting passwords (24 hour programs) and reporting system outages* 
11:00 pm to 4:30 am Reporting system outages* 

Weekends (Telephone) 
Hours Services 

4:30 am to 11:00 pm Resetting passwords (24 hour programs) and reporting system outages* 
11:00 pm to 4:30 am Reporting system outages* 

 
* By definition, a system outage affects multiple users. Examples include when: 
 -The system does not respond and appears to be frozen 
 -No data can be entered or viewed  
 

Support Desk Suggestions 
 

• Please consult with your program manager and your resource packet prior to 
contacting the Support Desk.   

 
• When calling for a password reset on weekdays between 4:30-6a or 6-11p, or 

calling weekends between 4:30a-11p, you must leave a message. Include your 
name, CCBH staff ID, phone number and the reason for your call.  

 
• You may be given a ticket/tracking number if you call between 6:00a and 6:00p 

Monday through Friday. Remember to keep this number for future reference. 
 

Additional Contacts 
 

Questions Where To Go 
Clinical Documentation Questions Documentation Manual/Your Program Manager 
Duplicate Clients and                                         
Name/DOB/Gender/SSN Changes 

Complete Form BHS-025 and                                                              
Call Medical Records: 619-692-5700 x 3 

Financial Questions (UMDAP/Insurance) Billing Unit: 619-338-2612  Fax- 858-467-9682 
Online User Manuals and Forms www.optumsandiego.com 
Service Codes CCBH (Anasazi) User Manual/QM Unit 
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